MS WORD 2007
for thesis writing

Outlining
Using styles
Table of contents
Document sections
Graphics

2009 Centre for Educational Technology, University of Cape Town
# Table of Contents

**Outlining** .................................................................................................................... 3  
  Why use outlining? ............................................................................................................. 3  
  Headings, subheadings, and body text ............................................................................. 3  

**Using styles** .................................................................................................................. 5  
  Styles are more than just formatting ................................................................................ 5  
  Using a predefined style .................................................................................................... 5  
  Using following styles ....................................................................................................... 6  
  Viewing your styles and formatting .................................................................................. 6  

**Table of contents** ......................................................................................................... 7  
  Heading levels are all you need .......................................................................................... 7  
  To insert a table of contents ............................................................................................. 7  

**Page layout and section breaks** .................................................................................... 8  
  Page margins .................................................................................................................... 8  
  Sections .............................................................................................................................. 8  
  Headers and footers .......................................................................................................... 9  

**Graphics** ..................................................................................................................... 10  
  Some terminology .......................................................................................................... 10  
  Inserting and resizing pictures ....................................................................................... 10  
  Graphics layouts ............................................................................................................. 11  

**In closing** .................................................................................................................. 12  
  Hyphenation .................................................................................................................... 12  
  Spelling and Grammar checking ..................................................................................... 12  

**Exercise** ...................................................................................................................... 14  
  A. Outline a document ...................................................................................................... 14  
  B. Apply and modify a style ............................................................................................. 15  
  C. Create a table of contents ........................................................................................... 16  
  D. Insert a footer ............................................................................................................. 17  
  E. Insert a graphic ............................................................................................................ 17
Outlining

Why use outlining?
Outlining makes it really easy to plan the structure and content of a complex document. With outlining you can move a heading and its accompanying text to a different part of the document; you can modify the hierarchical structure of a document; and you can hide parts of the document from view while you focus on the current section.

Outline view is just another way of looking at your document (like print layout view or draft view). A good way to get started on a large writing task is to enter key headings and subheadings in outline view, and then switch to print layout view for entering details.

To switch to outline views in Word, click View – Document Views, and select Outline view.

A new outlining tab will appear on the ribbon: the tools on the left are used to reorganise text, while the tools on the right control the way it is displayed.

Headings, subheadings, and body text
Every heading has a level, with the most important headings at level 1. The + or – button next to a heading lets you expand or contract the text under that heading.

Body text is attached to the heading above it. It is indicated by a dot, and can be partially or completely hidden.

If you promote a topic, it moves one level up in the hierarchy, for example a level 3 heading becomes a level 2 heading if it is promoted. You can choose whether the subheadings beneath it should also be promoted. A heading that is demoted becomes a subheading of another topic.

To promote or demote a heading, click in the header text and drag it to the left or to the right. Alternatively, use Outlining – Outline Tools to manage the position of headings and text.

To change a heading level using the ribbon:
1. Click anywhere inside the heading text.
2. Click on one of the green arrow buttons to Promote to Heading 1, Promote, Demote, or Demote to Body Text. Alternatively, select a heading level from the drop down list.

To move an outline item to a different part of the document:
1. Click anywhere inside the heading text.
Note: If you also want to move the subtopics under the current heading, then the current heading must be collapsed so that the subtopics aren’t visible, or else the subtopics must be selected along with the heading that is to be moved.

2. Drag the heading to the position where you want it to appear. You can also use the Move Up and Move Down buttons under the Outlining tab.

Expanding and collapsing levels within the document help you to focus on the section that you are currently busy with. You can toggle between the expanded or collapsed state by double-clicking on the + sign to the left of the heading. (A minus sign next to heading means that it has no subtopics.) To expand or collapse levels for the entire document, use Outlining – Outline Tools – Show Level.

You can expand or collapse body text by double-clicking on the heading above it. You can also click the outlining button to Show First Line Only.
Using styles

Styles are more than just formatting

Formatting in Word can be applied at the character, paragraph or section level. Styles give you a way of organising and consistently applying a combination of different formats to your text.

To apply a style to an entire paragraph, just click anywhere in the paragraph and then select the required style. To format smaller pieces of text, you need to first select the text before applying the style. The live preview feature in Word 2007 lets you see the appearance of a style before you actually apply it.

Word comes with a predefined collection of styles that cater for body text, headings, lists, tables, etc. Consider whether one of these will suit your needs. If not, you may want to modify an existing style, or perhaps develop your own style set from scratch.

Using a predefined style

The easiest option is to start with one of the existing Word style sets. To see whether there is a style that’s appropriate for you, change to Print Layout view, and then:

1. Open a document that includes a range of text types, such as a heading, body text, table and bullet list.
2. Go to Home – Styles – Change styles – Style set, mouse over the various styles on the list and select the one that is closest to what you have in mind.

If you want to modify a predefined style:

1. Use Home – Styles – Change styles if you want to change the font style and colour for the Normal paragraph style and for the Heading styles.
2. To modify paragraph formatting (alignment, indent, line spacing, etc), right-click the button for that style, or else open the *Styles* window, click the down-arrow on the right of a style name, and select *Modify*.

3. If you need other styles that aren’t included in the Word style set (such as boxed sidebar paragraphs), then you can create new styles using the *New Style* icon at the bottom of the *Styles* windows.

4. When you’ve finished customising the style set, go to *Home – Change Styles – Style Set – Save as Quick Style Set*, and then save it with a new name.

The good news is that if you create your document using styles, then at any later stage you can amend the formatting of those styles and the changes you make will automatically be reflected in your document.

An easy way to change a set of styles is to make the required change to their *base style*. Most customised styles are defined by adding formatting features to the Normal style. This means that by changing the Normal style, you can simultaneously change a whole range of customised styles that all incorporate the Normal style formatting as their base.

**Using following styles**

Switching between different styles within a document becomes much easier if you understand the concept of a following style.

Usually, when you press Enter at the end of a paragraph, the next paragraph will be in the same style as the one that preceded it. But in some cases, you don’t want this to happen. You might want every Level 1 heading to be followed by a Level 2 heading; and you might want your Level 2 headings to be followed by body text.

In that case, it’s going to simplify your life if you customise your styles by specifying *Style for the following paragraph* in the *Modify Style* dialog box. Then when you press Enter at the end of one paragraph, you will automatically change to the style that you want to use for the next paragraph.

**Viewing your styles and formatting**

At the bottom of the *Styles* pane, the *Style Inspector* icon will open a box that shows you the current style plus any additional formatting that has been applied on top of that style.
Table of contents

Heading levels are all you need

This is another good reason to use styles and outlining in your document. If you’ve defined your various heading levels using either (or both) of these features, then it will be a piece of cake to generate your table of contents. After all, the table of contents is just a list of the various headings and subheadings within the document.

If you also want to generate a table of figures, then the easiest way to do this is to insert caption labels for your figures using References – Insert Caption. The table of figures will derive its entries from these captions.

To insert a table of contents
1. Under the References tab, click Table of Contents and you’ll see a selection of built-in TOC formats, as well as the option to Insert Table of Contents.
2. Click at the point in the document where you want the table of contents to be inserted.
3. Click on Insert Table of Contents to open a dialog box.
4. Select the number of heading levels to be shown.
5. If you want to change the font, line spacing etc to be used in the table of contents, then click the Modify button and modify the TOC style at each level.
6. Click OK to generate a table of contents.

To update a table of contents, right-click anywhere in the table of contents and select Update Field.
Page layout and section breaks

Page margins
Single-sided printing doesn’t usually involve very sophisticated page setup, although you may want to leave a wider margin (or a gutter) on the left side of the page to allow for binding. For double-sided printing, it can be a good idea to use the Mirror margins option, in addition to allowing a gutter. Use Page layout – Page setup – Margins - Custom margins to change these settings.

Sections
The longer and more complicated your document is, the you’ll need to make use of sections. Each section in a document can have its own page formatting, which is invaluable if for example you need to switch between portrait and landscape orientation for a few pages, or use multiple columns per page for a section of the document. You would also use a new section to restart the page numbering, or to change the header or footer.

Next page section breaks will start the new section on a new page (useful if you are changing the page margins); continuous section breaks apply from the point of insertion (allowing multiple columns within one part of a single page). There are also even and odd page options, which you can use to ensure that all new sections will start on a left or right facing page.

To insert a section break and change the page orientation from portrait to landscape:
1. You should be in Print Layout view. Click within the text at the point where you want the section break to occur (usually at the end of a sentence or paragraph).
2. Insert the section break by clicking Page Layout – Page Setup – Breaks, and selecting Next Page from the section breaks menu.
3. Change the page orientation by ensuring that the insertion pointer is in the new section, and clicking Page Layout – Page Setup – Orientation – Landscape. Pages before the section break will be in portrait mode, and those after the section break will be landscape.

To delete a section break, change to Draft view, select the dotted double line that represents a section break, and press Delete.
Headers and footers

Headers and footers are printed at the top and bottom of every page in the document, and may differ from section to section within the document. They can contain fields that are automatically updated as well as fixed text. Headers and footers are accessed from the Insert tab, where you’ll find a selection of predefined (and customisable) building blocks as well as the option to create your own header and footer from scratch.

The same principles apply for inserting, modifying or creating a footer as for a header; just click on the appropriate header or footer button on the ribbon.

To insert a header building block:
1. Go to Insert – Header & footer – Header and scroll down to select a header building block. For this example we’ll use Annual.
2. Click the Annual header to insert it into your document.
3. Click on the bracketed words “Type the document title”, and type a title of your choice. (The title you enter here will also be stored in the document properties.)
4. Click on the bracketed word “Year”, and select a date or else type the year that you want.
5. Save your header by clicking the Close Header & Footer button, or else by double-clicking anywhere in the document body.

To create a custom footer (or header):
1. Go to Insert – Header & Footer – Footer, and select Edit Footer.
2. Type the text that you want included at the left margin of the footer. For two lines of text, press Enter after the first line and then type a second line of text.
3. Press Tab once to move to the centre of the footer, then press Tab again to move to the right margin.
4. Type “Page” and press the space bar.
5. To insert the page number, look under the Header & Footer Tools heading and click Design – Insert – Quick Parts – Field. Scroll down the list of field names and select Page. Because this is a field, the page number will be greyed out.
6. Type a space, then “of” followed by a space. Open the Field box again and select NumPages. The footer text should read eg “Page 2 of 4”. Close the footer.

Finally, to delete an existing header, go to Insert – Header & Footer – Header, and at the bottom of the menu you’ll see the Remove Header command. You can follow a similar process to remove a footer.
Graphics

Some terminology

A picture is a two-dimensional image of something, which contains no further level of detail than you can see on the screen. You can’t change a picture of a pie chart into a picture of the equivalent bar chart – you would need to go back to Excel, create the bar chart, and then copy that as a picture back into your document in place of the previous pie chart.

An object can be created within your document, or created using another program and then included in your document. The original elements used to create the image that you see, are part of that object, so that it can be edited from within the document. For example, if you include a chart object in your document, then the underlying raw data is also part of that object, and you would be able to change the chart type from within the document. Because embedded objects contain more data than pictures, they generate much larger file sizes. Also, you may not want the raw data to be available to everybody who has access to your document.

An embedded object can be viewed in the document, even if the source file from which it originated is not available. To edit the object, you need to have the relevant program (eg Excel) available to you.

A linked object requires access to the original source file in order to be able to view it. This means that if you create a graphic and include it in your document as a linked object, then copy the document (but not the source file) to another PC, the graphic will no longer be displayed. To edit the graphic, you need both the source file and the relevant application program.

By using Copy and then Paste Special, you can select whether you want a graphic to be included in your document as a picture or as a particular object type. It is usually preferable to insert a graphic as a picture, which protects the confidentiality of the underlying data and minimises the size of the document file. You can convert embedded or linked objects (other than Excel charts) into pictures, by selecting the object and then pressing Ctrl + Shift + F9.

If you’ll be pasting graphics into your documents, it’s worth knowing which file types are the most economical in terms of size.

- PNG and JPG are the most efficient formats to use;
- BMP (bitmap) provides better quality but a much larger file size;
- TIF is not widely available, but can provide the best quality for combinations of graphics and text.

Inserting and resizing pictures

After you have inserted a picture in your document, you can resize it, move it, or change the way that text flows around it.

- To insert a picture, click at the place in the document where you want the picture to be inserted. Click Insert – Illustrations – Picture, browse to select the picture that is required, and double-click to place it in your document. Alternatively, first Copy the picture to the clipboard and then Paste it at the desired location in the document.
- To resize a picture, drag any of the sizing handles around the border of the image. (Note that pictures have round handles at the corners and square handles at each side.)
- To retain the original image proportions, press Shift as you drag the sizing handles.
- To anchor the centre of the image, press Ctrl as you drag the sizing handles.
- To rotate an image, drag the handle that sticks out from the centre top.
• To position an image at one of the page margins, or to centre it, find the Format tab under the Picture Tools ribbon heading, and click the Position menu.

Graphics layouts
For most graphics, the simplest layout option to use is In Line With Text. To specify this layout, select the graphic and then under Picture Tools, click Format – Text Wrapping – In Line With Text. This setting allows you to format your graphic as you would format text, for example alignment, indent, and spacing before and after.

If you need to overlap a graphic and text, then your best text wrapping choice is likely to be Behind Text. This sometimes makes it difficult to select the graphic – you can do so by clicking Home – Select – Select Object, will which ignore the text in front of the object.
In closing…

Hyphenation
By default, when a word is too long to fit at the end of a line, word will move the entire word down to the next line. This can result in a very jagged right margin, or large gaps between words for justified text (aligned on both the left and right). Word offers a choice of three hyphenation styles:

- None (default)
- Automatic (based on simple rules)
- Manual (you decide for each word)

You can access the hyphenation options with Page Layout – Page Setup – Hyphenation. To adjust the automatic hyphenation rules, select the Hyphenation Options button: the Hyphenation zone specifies the maximum size of gap to be left at the end of a line, and Limit consecutive hyphens specifies the maximum number of consecutive lines that can be hyphenated. If you select the Manual hyphenation option in the same box, then Word will show you suggested hyphen positions and give you the option of changing them.

To remove automatic hyphenation, click Page Layout – Page Setup – Hyphenation and select None.

To remove manual hyphenation, you need to use Find & Replace: under the Replace tab click the Special button, and then look for the “Optional Hyphen” code ^-. Leave the Replace with box empty, and click Replace All.

Spelling and Grammar checking
Inaccuracies in spelling and grammar undermine the quality and credibility of your work. So it’s worth using the tools that Word provides for checking spelling and grammar; and also worth taking a moment to make them work the way that best suits you.

If you don’t want Word to underline questionable words (red) or grammar (green), then
1. Click on the Office button, and select Word Options in the lower right corner
2. Click on Proofing, and locate the section When correcting spelling and grammar in Word.
3. Uncheck “Check spelling as you type”.
4. Uncheck “Check grammar with spelling”.
5. Click OK to close the Word Options window.

If you choose not to check spelling and grammar as you type, then you will need to check it manually for the document as a whole. Do this with Review – Proofing – Spelling & Grammar.

Don’t forget that Word’s Thesaurus offers a range of alternative words to expand your vocabulary. Right-click the word that you want an alternative for, and then select Synonyms from the pop-up menu.

You can also translate words into a limited set of other languages: select the required word in your text, and then click Review – Proofing – Translate.
Exercise

A. Outline a document

1. Type the text shown in the first column below.

<table>
<thead>
<tr>
<th>Gardening for beginners</th>
<th>Body text</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Understanding your environment</strong></td>
<td>Heading 1</td>
</tr>
<tr>
<td>Climate</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Soil types</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Planning</td>
<td>Heading 2</td>
</tr>
<tr>
<td><strong>Successful planting</strong></td>
<td>Heading 1</td>
</tr>
<tr>
<td>Prepare the site</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Choose plants that will thrive</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Special effects</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Container planting</td>
<td>Heading 2</td>
</tr>
<tr>
<td><strong>Potential problems</strong></td>
<td>Heading 1</td>
</tr>
<tr>
<td>Insects</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Diseases</td>
<td>Heading 2</td>
</tr>
<tr>
<td>Nutrient requirements</td>
<td>Heading 2</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>Heading 1</td>
</tr>
</tbody>
</table>

2. Save your document with the name **Garden**.

3. Use Word outlining to set the heading levels shown in the second column.
B. Apply and modify a style

1. Return to print layout and choose the style set **Elegant**.
2. Select the first line of text and apply the Title style.
3. Right-click on the Heading 1 style icon, and select **Modify**. Change the space before each paragraph to be 16 point. Set the style for the following paragraph to be Heading 2.
4. For Heading 2, change the space after to be 4 point, and the following style to be body text.
5. Modify the Normal style to be single spacing with a 10 point space after each paragraph.
6. Save the changed style set with the name **Tutorial**.
7. In your document, press *Enter* once after each of the level 2 headings, and add some random text.

---

**GARDENING FOR BEGINNERS**

**UNDERSTANDING YOUR ENVIRONMENT**

**CLIMATE**

Climate will affect how much water you need to give your plants, and whether they need to be able withstand frost or dry conditions.

**SOIL TYPES**

If you have sandy soil you will need to water your plants more frequently, and also fertilise more often. Clay soil holds water and nutrients for longer.

---

8. Return to outline view to see your document structure.

---

9. Save the document again.
C. Create a table of contents

1. Return to print layout and go to the beginning of your document
2. Insert a next page section break and go to the top of the document.
3. Type “Table of Contents” and format with Title style. Press Enter twice.
4. Open the Insert Table of Contents dialogue box.

5. Specify that the TOC should show only two levels.
6. Modify the TOC 1 format to be 11 point bold.
7. Be impressed by your Table of Contents! Then save the document again.
D. Insert a footer

1. In section 1 of your document, insert a footer using Blank layout.
2. In the text field type “Copyright", then your name, then “2009”.
3. Page down to section 2 of the document
4. Under the Design tab, uncheck Link to Previous (you want a different footer for section 2).
5. At the left edge of the text area, type “Gardening for Beginners”.
6. Press Tab twice and enter the page number.
7. Click the Page Number icon, and format the page number to start at 1.
8. Close the footer and return to print layout view.
9. Save the document.

E. Insert a graphic

1. Go to Google images and find a picture of a flower. Copy it to the clipboard.
2. Create a blank line under the text in the Climate section of your document, and insert the picture.
3. Use the toolbar icon to indent it by one tab stop.
4. Select the picture and use References – Captions to Insert a Caption.
5. Indent the caption by one tab stop.
6. Save the document one last time.